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Part 1:
Introduction

What is the purpose of this guide?
Like it’s title suggests, this guide gives you step-by-step instructions on how to use
HyperStudio 4 to create mouse or switch operated talking books using pictures scanned in
from real books.

Why do we need talking books?
Access to literature is of crucial importance in the education of all pupils, including those with
special educational needs. There has been a great expansion in the use of storybooks in
schools with a large number of reading books linked to the National Literacy Strategy. The pro-
liferation of big books for group reading and the opening up of literacy into more stimulating
and colourful reading books have especially helped in this expansion into special education.

There are, however, a number of pupils who cannot read independently because of their
physical difficulties. They cannot turn to the next page of a book, skip ahead to find ‘the excit-
ing bits’ or turn back to re-read a page.  They always have to ask someone else to hold their
books and turn the pages for them. Their reading development is often delayed, even if they
are of normal intelligence.

Most of the children visiting the ACE centre can, like our patron Professor Stephen Hawking,
independently access reading materials or books via one or two switches attached to a comput-
er. Children can access electronically published books using a variety of computer access aids
including activating a switch with whatever part of their body has the best voluntary control.
Unfortunately, the range of electronically available books for children is very limited and for
disabled children to develop as readers, they need access to the same range of books as other
children. 

It is, however, now possible to create your own books on the computer using hardware and
software that is generally available in schools and many homes. These ‘talking books’ can be
tailor-made to the interests and abilities of the pupils, text can be symbol-supported, and
sounds and speech can be included to enable access to those with reading difficulties.

Children can actively help to make their own accessible talking books, and this opens up
more possibilities of creative and imaginative writing for pupils with learning difficulties.
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A well-known example of talking books
is produced by Sherston Software as
the Oxford Reading Tree series (an
example is shown on the right). The
page layout is simple and consistent,
and the controls are clear and straight-
forward. We shall be using a similar
layout to construct our own talking
books.

Our books will be set up initially for
operation by positional mouse switch-
ing, where the left mouse button has

to be pressed when the mouse arrow is over the active icon and the mouse has to be moved
precisely to each of the active areas. This presents difficulties to pupils who can’t control a
mouse or move a pointer accurately, so later on we will be looking at modifying our talking
book to allow access from a keyboard, switches or an overlay board. 

Before you start...
Before you start gathering together piles of books to convert, be aware that putting together
even a single talking book will take time. Creating a template (a master page that contains the
page format and the buttons for turning the pages and listening to the words) at the outset
will save hours of time when making a number of books, but even if you only intend to make
one, do create a template first.
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Part 2:
Important! 
The copyright issue

There are obviously copyright considerations involved in reproducing pages from printed
books. The publishers of the books used to illustrate this guide have all given express permis-
sion for them to be converted into multimedia by the addition of symbols, as long as copies are
not sold, and the copyright line on the book’s cover is included in the talking book.

There are some guidelines (as of Sept 2001) on copyright issues on the World Wide Web at:

www.pls.org.uk

These are reproduced below. Take particular note of the text in bold (our emboldening),
which sanctions the creation of multimedia copies of books for the personal use of individuals
with visual or physical difficulties. The creation and use of multimedia copies of books for
school and class use by people with special educational needs in schools still seems open to
interpretation. If you are in doubt, contact the publisher, but check that they are aware of the
new guidelines as they may well help your case. 

Joint Industry Guidelines
These guidelines cover access to books, magazines and journals by visually impaired people.
They do not constitute legal advice but are for guidance only:

Introduction 
a These Guidelines are the result of a wide-ranging consultation among rightsholders and

organisations helping visually impaired people in an effort to strike a balance between
the requirements of visually impaired people and the special problems surrounding
uncontrolled copying, transcription and distribution. 

b Rightsholders including authors, their agents and publishers wish to make their works
accessible to all members of the public. 

c Where visually impaired people cannot read works in formats commercially available
they will in some cases wish to copy, record or transcribe the works into a format accessi-
ble to them. The issue of who may create and distribute copies in different formats, in
particular electronic copies, is important for rightsholders. 

d These Guidelines have been drawn up to assist visually impaired users and those acting
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on their behalf to understand current trade practice with regard to acts of copying they
can assume they are allowed to do without requesting prior permission from the rightsh-
older, provided the conditions described below are met. In case of doubt users should
always consult the rightsholder. 

e Rightsholders support the work of charities and volunteer organisations in making books
and journals accessible to visually impaired people. The permissions they require to dis-
tribute such works are outside the scope of these Guidelines. 

f For the purposes of these Guidelines visually impaired people are taken to include blind
and partially sighted persons, those whose sight cannot be improved by the use of cor-
rective lenses, those who are unable through physical disability to hold or manipulate
books or to focus or move their eyes or who are otherwise physically unable to use avail-
able published formats. 

Guidelines
1 Visually impaired people who have lawfully obtained a copy of a published work,

whether bought or borrowed, may make whatever transcription, copy or format changes
they require to enable personal access to the work, including speech synthesis, Braille,
Moon, large print, single voice recording (speech), electronic file, provided the work is not
readily commercially available in a suitable format. 

2 Visually impaired people may ask another person or organisation, including schools,
libraries and charities, to create an accessible copy on their behalf, provided that any
such copy is made for the personal use of the visually impaired person concerned only.
This includes use for the purpose of work or study.

3 A non-electronic copy e.g. single voice recording (speech) or a Braille copy may be bor-
rowed or exchanged among visually impaired people as if it were the print original itself. 

4 Electronic copies may be created and stored on a computer system for as long as
required to enable personal use of the work while the original is retained. They may not
be made accessible or passed on to a third party or posted on an Intranet, in newsgroups
or on the World Wide Web. If the original is lent, sold or given away, then any accessible
copies and associated electronic files must be deleted or transferred with the original. 

5 Visually impaired people must respect the literary and artistic integrity of the work
including any copyright notices and any moral rights the author may have in the work.
They must not in any way adapt, edit, alter, amend or distort the work, other than as
required to enable full access, without the prior permission of the author or his or her
designated representative. 

6 The copyright remains with the copyright owner. Rightsholders retain the right to
exclude the use of certain formats in special circumstances and permission must be
sought for such use from the relevant rightsholders. 

The development of these guidelines has been supported by: 
Association of Authors’ Agents, Association of Learned and Professional Society Publishers, Authors’
Licensing and Collecting Society, Copyright Licensing Agency, Music Publishers Association, National Union
of Journalists, Publishers’ Association, Publishers Licensing Society, Periodical Publishers Association, Scottish
Publishers Association, Society of Authors, Writers’ Guild of Great Britain.
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You will first need to prepare the resources for your talking book. This entails:

1 Creating a folder on the computer in which to save all your resources
2 Creating pictures for your talking book
3 Creating symbols to support the text in the books

Creating a folder for all your resources
It’s always a good idea to keep all your talking book resources together in one folder so that
they can be located easily. You need first to decide where you want to create a new folder to
put your resources. Two good options are in My documents, a folder that is already on most
computers, or by creating a new folder on the Windows desktop.

1 Open the My documents folder from the Windows desktop screen:

2 On the File menu, Click on New, and then click Folder:

Part 3:
Getting your
resources together
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The new folder appears with the temporary name "New Folder":

3 Type a name for the new folder, and then press Return on the keyboard. 

Alternatively you could create a folder on the Windows desktop screen by clicking anywhere on
the screen with the right-hand mouse button and then clicking on New, then Folder:

Rename the folder in a similar way to the first method.

Creating pictures for your talking book
There are a number of sources for your pictures. You can scan them from a book using a
flatbed scanner, use digital camera photographs, or use clipart and graphics from the comput-
er. We will look at using these three sources in turn:

Scanning pictures
Scanners can be purchased for as little as £50 and some computer sys-
tems already come with one. They work by moving a row of light recep-
tors slowly down the page or picture to be scanned. A certain proportion
of the light is reflected back from the picture which then produces an
electrical signal, building up an electronic image of the page. All scanners
use the same standard software to interact with the computer in
Windows called Twain.

You can scan in pictures using software such as PaintShop Pro, Adobe PhotoDeluxe and
Irfanview. In the File menu there will be an option to Acquire an image from a Twain picture

A desktop scanner
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source such as a scanner. Choosing this option will start your scanner’s software, and you can
then preview and scan parts of a picture. Irfanview is an freeware program that can be down
loaded from http://www.irfanview.com

1 Opening your scanning software
To operate a scanner in Irfanview, click on File and then Acquire:

Acquire opens the scanning window

To find Acquire in PaintShop Pro, click on File, Import, Twain and then Acquire:

Choosing Acquire will open up the scanning window. This will be slightly different for dif-
ferent models of scanner and their software.
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All scanner software will have Preview and Scan buttons. When you press the Preview
button, you get a quick mini-scan of entire scanner bed. Using the mouse you can drag
out a rectangle on the preview image and mark the area you want to scan. You can fur-
ther adjust the size and shape of this area by clicking on and dragging any of the six
small blocks on the edge of the rectangle. Don’t click the Scan button just yet.

2 Picking the best resolution for your scanned pictures
Somewhere on the settings screen of all scanning software there will be an area where
you can specify the Resolution (sometimes called Output Resolution) for your final scan.
The higher the resolution, the larger the file size of the scanned picture, so generally the
scanner’s resolution should be set at 72dpi, unless you are scanning a particularly small
picture that may have to be greatly enlarged when it appears within your talking book. In
this case, specify 150dpi. Scanning at a higher resolution only creates extra information
that the screen display will ignore, and slows down the displaying of the images.

There are lots of other controls you can change in the scanning software to alter the
quality of the image. You can alter the Gamma, Saturation and Hue of your scanned
images, but unless you have a great deal of time, I would recommend that you leave
these controls alone and just use the default settings. 

3 Scanning your pictures
Click Scan to scan your image. After the scanner has finished, your image will appear on
the screen.

4 Picking the best file format for saving your scanned pictures
When you save your scanned picture on the computer, it is important to choose the right
format for them. The format can have a very significant effect on the amount of space
your scanned picture file takes up on the computer. You can usually find the list of for-
mat options by clicking Save As in your scanner software. If not, try Export if it exists.

• For scans of illustrations or photographs, choose JPEG.  
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• For scans of symbols, black and white line drawings, or cartoons containing solid 
blocks of colour (like the Mr Men books), choose GIF, although JPEG would be OK as 
an alternative.

Your software may offer you a default option of Windows bitmap (BMP), but this is not
generally recommended for talking books, as scans in this format will produce much
larger files.

If you want to name your scans numerically, use 01, 02, 03 .... 09 for the first nine files
rather than 1, 2, 3. They will all then be listed before file 10 in your file windows.

I would recommend scanning in all the pictures from any book all in one session, and
save them as picture01, picture02, etc. Scanners are temperamental machines and once
started, I have found it better to go through to the end. 

Using digital camera pictures
The use of digital cameras in schools has recently increased considerably due to the advances
in digital camera technologies (they have become much cheaper, with better picture quality
and faster downloading of the photos onto the computer). Digital camera pictures can be
incorporated into talking books in the same manner as scanned images. After downloading
your pictures onto the computer using your camera’s software, they can be treated the same
as any other computer graphic.

Using clipart or pictures from the computer
You will probably find a large number of pictures already installed on your computer (Microsoft
Office, for example, comes with a good number of clipart pictures) and you can get many more
pictures and graphics (of varying quality) on commercial CD-ROMS. All can also be incorporat-
ed into your talking books. The Internet can also be a source of picture files (for example
www.clipart.co.uk or images.google.com), and the CALL Centre (callcentre.education.ed.ac.uk)
produce a useful list of clipart websites.

Creating symbols for your talking book
Symbols can be added to support the text of your talking books. Sources of symbols include the
Writing with Symbols CD (from Widgit Software), Inclusive Writer (from Inclusive Technology),
Clicker (from Crick Software), and Intellipics (from Intellitools or Inclusive Technology).

How to add symbols
Images of single symbols can be added in the same way as adding any other picture or graphic
to your talking book. 
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How to create images of symbol sentences
To add symbol sentences you will need a copy of the symbol writing software.

1 Write your sentences into the symbol processor
Amend or choose the symbols, as you want using the controls within the symbol proces-
sor and thicken the lines to at least size 2. It’s best to make your sentence fairly large, but
not so large that the end of it extends beyond the bottom of the screen.

2 Capture the image on the screen
Move the cursor off the screen by pressing the Return key a couple of times. Then hold
down the ALT key whilst pressing the Print Screen key to capture an image of the screen
(the Print Screen key is usually towards the top right-hand side of the keyboard before
the numeric keys; it may be called Print Scrn or PrtScr). Although nothing will appear to
happen when the keys are pressed, an image of part of the screen (called a Screen Dump)
is stored temporarily into the computer’s memory, ready for pasting.

3  Paste the screen image into a graphics program
Start Irfanview (or your chosen graphics program) and choose Paste from the File menu
(or press CTRL and V together on the keyboard):
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This will load your screen dump into Irfanview where it can be edited:

4  Crop the symbol picture out of the screen dump
The symbol sentence will now need to be cut from the background using an image edit-
ing program like PaintShop Pro, Adobe PhotoDeluxe or Irfanview. The technique involves
cutting the part of the picture that you need away from the the remainder. In Irfanview,
crop the symbol sentence by clicking and dragging a mouse outline over the symbols:

In other picture editing programs you might have to choose a specific Crop control:

In Irfanview, press CTRL and Y together to crop the picture or click Crop in the Edit menu.
This will remove the parts of the image outside your rectangle. In PaintShop Pro you
would choose the Crop control to draw an outline rectangle and then double-click inside
the rectangle.

The Crop control in PaintShop Pro
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The image will then look like this:

5 Save the cropped symbol picture
Save the symbol sentence in the folder you have previously made.

Choose the GIF format. This is the best format for line drawings.

The finished graphic of the symbol sentence will look like this: 

This is now ready to be added to your talking book.
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Part 4:
Setting up a template
for your talking book

The first thing to do when you open HyperStudio is to create a template for your talking book
that consists of a blank page containing only the Next Page, Previous Page and Speak Text but-
tons. You can then use this template for all the pages of your book.

Create a blank page for your template
Click on the File menu and select
New Stack.

A blank page (which HyperStudio
calls a Stack) will appear with a
message box telling you that
you’ve just created a new stack.
Click OK.

Click on the Extras menu and select Shortcuts.

The Shortcuts menu will appear. This contains the controls you
need to set up your template. The menu will always stay at the
front of your screen so you don’t have to keep reopening it.
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Adding navigation buttons to your template
The next stage is to add the navigation buttons to your page template. Use the following pro-
cedure to create a Next Page button first, then repeat it to create a Previous Page button.

1 Adding the Next Page button
Click on Add Button in the Shortcuts menu.

The Button Appearance dia-
logue box will appear:

Click the Icons button...

... click on the picture of the for-
ward arrow, then click OK.

The Button Appearance
dialogue box will appear.
Name the button by click-
ing in the text box and
typing ‘forwards’. 

Then click OK.
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The  forward arrow will
appear on the blank page:

Move this button to the
corner of the page by click-
ing and dragging with the
mouse.

Move the cursor outside the forwards
arrow box and click the mouse button.
The Actions dialogue box will appear.
Click on Next card, then click Done.

The Transitions dialogue box will appear. You can choose
a suitable page turning transition (for example, the next
page sliding in from the right). Finish by clicking OK.

2 Adding the Previous Page button
The Previous Page button is added in the same way as the Next Page button, except that
you should:

• Choose the backwards arrow in the Icons dialogue box.
• Name the button ‘backwards’ in the Button Appearance dialogue box 
• Choose Previous card in the Actions dialogue box.
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Adding a speaker button to your template
You now need to add a speaker buttons to your page.

1 Adding the speaker button
Click on Add Button in the Shortcuts menu.

The Button Appearance dia-
logue box will appear:

Click the Icons button...

... scroll down the pictures of the
icons until you find the speaker.
Click on it, then click OK.

Rename the new button
‘listen’ and click OK.

Position the speaker icon at
the centre of the bottom of
the page and click outside it to
bring up the Actions dialogue
box.

Choose None of the above. We are only creating a
template so you don’t want to add a sound to the
page yet.
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Save your template
Click on the File menu, select Save Stack. Give the template a suitable name and click Save.

This is the template you have created:
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You are going to use the template to create the first and subsequent pages of your talking
book. If you want to know what the completed first page looks like, it’s shown on page 26. 

Start Hyperstudio, click on
File, then Open Stack

Make a set of blank linked pages

Click on your talking book template, and
click on Open

You now need to copy and
paste this page to make a 
number of linked pages...

Part 5:
Using the template to
create your pages 
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...so click on Edit, then on Copy Card

Then click on Paste (or hold the CTRL key and press V) for as
many blank pages as your story book needs. It is easy to add
or delete pages at any time.

These pages will be linked to each other by the forwards and
backwards arrows on each page.

You can check on the number of blank pages in
your ‘stack’ by clicking on Extras and then
StoryBoard.

Setting up the HyperStudio controls 
HyperStudio has two distinct modes of operation that you will use, Browse and Edit/Select.

The small hand is called the Browse tool. This is used to operate
and view the pages. 

The arrow is called the Edit/Selector tool. It’s used to edit the
pages.

Whilst you set up the talking book you will be in Edit/Selector mode. 
To use or test the talking book you need to be in Browse mode. You
can change between the two modes by pressing the Shift and Tab
keys together.
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You can move the tools palette from the menu bar to the side of your page where it will
remain open for easy access by clicking on the tools menu. Click and drag the tools palette to
the new location and then release the mouse button.

Here’s the Hyperstudio page ready for adding content to your talking book:

Adding pictures to your pages
To add a picture to a page, click on Add Graphic from the Shortcuts menu.
In the resulting dialogue box, select Disk file if you have already scanned
in all the pictures onto your computer. (If you haven’t, choose Twain
scanner or video to activate your scanner’s software and scan your pic-
tures as described in part 3).

Clicking OK will open a window (below) on your
screen from which you can choose a picture. Select
your first picture, then click Open.
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The Graphics Objects dialogue box will appear with your chosen picture.

Click on the outline box...

...The mouse arrow will change to a
crosshair with which you can click and
drag an outline box around the part of
the picture you need. Click OK, and an
information box will appear. Click OK in this box as
well. Position and resize the picture on the page by
clicking and dragging with the mouse, then click
outside the picture to fix it on the page.

Here is the page with your picture:



Adding symbols to your pages
Add the symbols in the same way as the picture. Click on Add Graphic
from the Shortcuts menu. This will open the dialogue box shown below
to the left. 

Click on Disk file if you have already scanned in all the symbols onto your
computer. Clicking OK will open a window on your screen from which
you can choose a previously saved symbol graphic. Do this and click OK.

Click on the outline box and
drag the cross hair cursor
over the part of the graphic
you want to add to the
page. Then click OK.

Position it on the page
with the mouse and
click outside the picture
on the page to fix it
onto the page.
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Adding plain text to your pages
You can add plain text to the book’s pages instead of symbols.

Click on Add Text Object in the Shortcuts menu.

Then click OK in the resulting dia-
logue box. Click and drag the outline
rectangle on the page to position it
and click outside the rectangle on
the page. The Text Appearance box
will appear.

Make sure the two boxes Draw
scroll bar and Scrollable are
unticked. Click on OK.

The text you type will be shown on your page:
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To finish your pages, you must add speech to each of them. Start by double clicking on the
loudspeaker icon to add a sound to the button. The Button Appearance dialogue box will
appear:

Click Actions

The Actions dialogue box will appear:

Select Play a sound, and click Done. The
Digital Audio Deck will then open.

Here you can record your voice or load
in a sound file. To record your speech,
click on RECORD and speak into the
microphone. Click on STOP to finish.
Follow the same procedures to record
speech or sounds for the rest of your
pages.

Part 6:
Adding speech to
your pages
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This is the completed first page of the talking book in this tutorial: 
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The talking books that you have created are accessible to anyone who can control the mouse
and pointer, but they are not directly accessible by switches or by an overlay board. For users
who are unable to use a mouse, it’s straightforward to add access for either direct selection
through a keyboard or externally through a keyboard switch interface.

Connecting your switches
Your switches can be connected through your computer’s serial
port socket (via a switch interface box like the SEMERC Switch
Box II), or the keyboard socket (via a keyboard switch interface
box like the Don Johnson’s keyboard interface (pictured on the
right) or the Inclusive Technology’s Keyboard Switch Interface, or
a switch attached to the Intellikeys keyboard). Crick Software
also supply a USB Switch Interface Box.

Adding keyboard or switch access
You can configure each button on your page to be activated by pressing a key on the keyboard.
To do this, you need to set up a New Button Action (NBA) called KeyMapper.

Double click the Next button in your page. The Button Appearance window will open.

Click the Actions button at the
bottom of the box. The Actions
dialogue box will appear.

Part 7:
Adding switch access
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Select New button Actions.

The New Button Actions dialogue box will
open.

Choose KeyMapper NBA in the list box
on the left by clicking on it, then click
the Use this NBA button

The next New Button Actions box will
appear.

Choose a key from the keyboard that
you want to use to activate the button,
and type it into the empty box, fol-
lowed by a backwards slash(\), followed
by the name of the button. Click OK.

For example, m\forwards will enable
the key ‘m’ to activate the forwards
button (turning the page).

Repeat these steps for each of your buttons. The talking books can then be accessed
directly from the keyboard.

You can make switches or an overlay board operate the talking book by setting up
their interfaces to send the appropriate keyboard commands.

There are other NBAs (New Button Actions) that allow Hyperstudio to control a CD,
add multiple actions to a single button, or introduce a pause into the presentation of the
talking book.
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Part 8:
Getting creative with
talking stories

Perhaps one of the most exciting activities involved in making talking books is the creation of
new stories with pupils. These stories can be developed using the pupils’ own language and
can incorporate their own choices. This allows those with learning difficulties real access to
shared and creative writing. 

Commercial talking books with a simple interface are usually targeted for very young chil-
dren with age-appropriate language and topics. There are few talking books on a more adult
level that have the same simple interface.

The books that you create for your own pupils can be on more adult themes. It is possible to
incorporate feelings and activities that reflect young adults’ interests, while keeping the sim-
plicity of layout and control that pupils with learning difficulties need.

There are obviously many different methods in transferring pupils’ ideas and creative writing
to the computer. One method is to start with a story page planner sheet:

Name: Date:

Title:

Picture

text/symbols

Sounds/animation
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Pupils can build these pages into a storyboard, planning out their book by constructing the
individual pages.

I have found it most successful to use a ‘story starter’ that is based on either from a real situ-
ation or the continuation of a story line from a book. 

For example, here is the opening line taken from Metamorphosis by Franz Kafka:

You can develop the storyline by first asking some simple questions, shaping the story from
the pupils’ answers.

• How would Greg feel?
• What would he eat?
• How would he get out of bed?
• What would his family feel?

In this way the story can be developed, in the style of Franz Kafka, with creative writing gen-
erated by the pupils.

Another story we have made into an accessible symbol and talking book on the computer is
The Iron Man by Ted Hughes. You may wish to consider making your own talking book of this
story. The opening chapter from The Iron Man is not only an excellent piece of imaginative
writing, but it contains most of the elements that make for good shared reading; relatively
simple language, repetition, imagination, and well written, almost poetic, prose. It also has the
benefit of a story tape read by Ted Hughes himself that you can use alongside your computer.

All sorts of methds, including Rebus choice sheets and story cubes, can give pupils using AAC
communication methods access to imaginative creative writing. As always, the emphasis is
best put on possibilities, not barriers.

Enjoy your creative writing!
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